
                    [image: alt]
                
        
            
                                        
        
        
    

    
        

    


    
        
            
                                    
                        [image: pdfFiller]
                    
                            

                        
                
                    	Home
	
                                                                            For Business
                                                                        
                                        
                                                                                            Enterprise

                                                                                        Organizzazioni

                                            Medico

                                            Assicurazione

                                            Immobiliare

                                            Fiscalità e finanza

                                            Legale

                                            Risorse umane

                                            Vedi tutto

                                        

                                    

                                
	
                                                                            Sviluppatori
                                                                        
                                        
                                            API degli strumenti PDF

                                            API di pdfFiller

                                            Documentazione API

                                            Prezzi API

                                            Integrazioni
                                                
                                                    
                                                        Salesforce

                                                        Dynamics

                                                        Vedi tutto

                                                    

                                                

                                            

                                        

                                    

                                
	Funzionalità
	Supporto
	
                                                                                                                                    Inizia la prova gratuita
                                                
                                                                                                                        
	
                                            Prezzi
                                        
	Accedi


                
            

                        
                
                    
                
            

        

    



                            

            
                                    
    
        
            

        

        
            
                                                            Home

                                                                                
                            For Business

                            
                                Enterprise

                                Organizzazioni

                                Medico

                                Assicurazione

                                Immobiliare

                                Fiscalità e finanza

                                Vedi tutto

                            

                        

                                                                                
                            Sviluppatori

                            
                                API degli strumenti PDF

                                API di pdfFiller

                                Documentazione API

                                Prezzi API

                                Integrazioni

                            

                        

                                                                                Funzionalità

                                                                                Supporto

                                                                                Prezzi

                                                                                Accedi

                                                

        

        
                            Accedi

                Non hai un account? Inizia

                    

    




                            
            

            
                
            
    
        
                	
                    
                        Home
                    
                
	
                    Indice di funzionalità
                


    
        

        
                        Lay Phone Application
                    

                    
        
            

        

                    

    



    


                            Note: Integration described on this webpage may temporarily not be available.

            

        Today AUG 18TH, 2022*

        
            
                
                    
                        

                        
                            0

                            Forms filled

                        

                    

                

                
                    
                        

                        
                            0

                            Forms signed

                        

                    

                

                
                    
                        

                        
                            0

                            Forms sent

                        

                    

                

            

        

    




        
    
        
            
                
                    
                        
                        
                        [image: Function illustration]
                    
                    
                                                    Upload your document to the PDF editor
                                            

                

            

            
                
                    
                        
                        
                        [image: Function illustration]
                    
                    
                                                    Type anywhere or sign your form
                                            

                

            

            
                
                    
                        
                        
                        [image: Function illustration]
                    
                    
                                                    Print, email, fax,  or export
                                            

                

            

            
                
                    
                        
                        
                        [image: Function illustration]
                    
                    
                                                    Try it right now! Edit pdf
                                            

                

            

        

    


        
    
        Users trust to manage documents on pdfFiller platform

        
                                                
                        65.5K+

                        documents added daily

                    

                                    
                        53%

                        of documents created 
from templates

                    

                                    
                        4M

                        PDFs edited per month

                    

                                    
                        238K

                        documents shared 
per month

                    

                                    

    


            
    
        
            
                All-in-one PDF software
            

            
                A single pill for all your PDF headaches. Edit, fill out, eSign, and share – on any device.
            

            
                                    
                        Start free trial
                    
                            

            

            

        

    


                                                
            
                
            Lay Phone Application: make editing documents online a breeze

                The Portable Document Format or PDF is a universal file format used in business, thanks to its accessibility. You can open them on whatever device you have, and they will be readable similarly. It'll keep the same layout no matter you open it on Mac or an Android device.

                Data protection is another reason why do we would rather use PDF files to store and share sensitive data and documents. That’s why it is important to pick a secure editor, especially when working online. PDF files are not only password-protected, but analytics provided by an editing service allows document owners to identify those who’ve read their documents in order to track potential security breaches.

                pdfFiller is an online editor that lets you create, edit, sign, and share PDF using just one browser tab. The editor is integrated with major CRM programs, so users can sign and edit documents from Google Docs or Office 365. Forward it to others by email, fax or via sharing link, and get notified when someone opens and completes it.

                Use editing tools to type in text, annotate and highlight. Once a document is completed, download it to your device or save it to cloud storage. Add images to your PDF and edit its layout. Collaborate with users to fill out the document and request an attachment. Add fillable fields and send documents for signing. Change a page order.

                Get your documents completed in four simple steps:
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                        Start with the pdfFiller uploader.
                    

                            

                        
                                    02

                    
                        Click the Tools tab to use editing features such as text erasing, annotation, highlighting, etc.
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                        To insert fillable fields, click the 'Add Fillable Fields' tab on the right and add them for text, signatures, images and more.
                    

                            

                        
                                    04

                    
                        When finished, click Done and proceed to downloading, sending or printing your document.
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        What our customers say about pdfFiller

        See for yourself by reading reviews on the most popular resources:
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                                    2016-10-19

                                

                            

                            
                                
                                    Too many going back and forth tasks to complete a form. You need to make this more friendly for the user not experienced.  Make it like MS Word with what is available from the subscription,  as for example: when I needed to use the eraser, it brought me to a screen to purchase to get, even though I have a monthly subscription.  Not fair.
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                                    The platform is very good, it fulfills exactly what it promises, it is even compatible with the NVDA screen reader for people with visual limitations. Unfortunately there is no language version in PT-BR, and in some tool icons the NVDA screen reader does not read.
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                    Get a powerful PDF editor for your Mac or Windows PC

                    Install the desktop app to quickly edit PDFs, create fillable forms, and securely store your documents in the cloud.

                    
                        Download pdfFiller for Mac OS

                        Download pdfFiller for Windows PC
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                    Edit and manage PDFs from anywhere using your iOS or Android device

                    Install our mobile app and edit PDFs using an award-winning toolkit wherever you go.

                    
                        Download from App Store

                        Download from Google Play

                    

                

            

            
                
                    [image: Extension]
                    Get a PDF editor in your Google Chrome browser

                    Install the pdfFiller extension for Google Chrome to fill out and edit PDFs straight from search results.

                    Download from Chrome Web Store

                

            

        

    


    
    
        
            
                
                    pdfFiller scores top ratings in multiple categories on G2
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                                    For pdfFiller’s FAQs
                            

            
                                    Below is a list of the most common customer questions. If you can’t find an answer to your question, please don’t hesitate to reach out to us.
                            

            
                                    
                        
                            
How do you convert a PDF to a fillable form?
                        

                                                    Step 1: Load the PDF File. Open your pre-existing PDF form in PDF element, or you can choose to open an existing form template. Step 2: Recognize Form Fields Automatically. Step 3: Fill and Save the Form.

                                            

                                    
                        
                            
Why can't I fill and sign my PDF?
                        

                                                    Make sure that the security settings allow form filling. (See File > Properties > Security.) Sometimes form creators forget to convert their PDFs to interactive forms, or they intentionally design a form you can only fill in by hand. If you can't type in the form fields, then the fields are probably not interactive.

                                            

                                    
                        
                            
Why can't I fill out a PDF form?
                        

                                                    Make sure that the security settings allow form filling. (See File > Properties > Security.) Sometimes form creators forget to convert their PDFs to interactive forms, or they intentionally design a form you can only fill in by hand. If you can't type in the form fields, then the fields are probably not interactive.

                                            

                            

        

                                                        
    
    
    
    
        
            

            
                eSignature workflows made easy
            

            
                Sign, send for signature, and track documents in real-time with signNow.
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